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Disclaimer

The information in this manual is furnished for informational use only and subject to
change without notice. While every effort has beenmade to ensure that the information
contained in this user manual is accurate, up-to-date and reliable, EVS Broadcast
Equipment cannot be held responsible for inaccuracies or errors that may appear in this
publication.

Improvement Requests

Your comments will help us improve the quality of the user documentation. Do not
hesitate to send improvement requests, or report any error or inaccuracy on this user
manual by e-mail to doc@evs.com.

Regional Contacts

The address and phone number of the EVS headquarters are usually mentioned in the
Help > About menu in the user interface.

You will find the full list of addresses and phone numbers of local offices either at the end
of this user manual (for manuals on hardware products) or at the following page on the
EVS website: http://www.evs.com/contacts.

User Manuals on EVS Website

The latest version of the user manual, if any, and other user manuals on EVS products
can be found on the EVS download center, on the following webpage:
http://www.evs.com/downloadcenter.
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What's New?
In the user manual, the icon has been added on the left margin to highlight
information on new and updated features.

The sections updated to reflect the new andmodified features on Xedio Approval from
Xedio Suite 4.3 and 4.35 (compared to Xedio Suite 4.02) are listed below.

Audio mono tracks can be used in the Xedio Suite

• See section "Selecting Video and Audio Tracks for Media and Clips" on page 19.
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1. Introduction

1.1. Product Description
Xedio Approval is an application of the Xedio Suite that allows editorial control over the
media and edits items that are produced within the system.

All media, clips and edits can be accessed and previewed before being either accepted or
rejected for transmission.

1.2. Opening Xedio Approval
To start the Xedio Approval application, click on theXedio Approval icon on the desktop

.

This will display a login screen where you need to enter your username and password.
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1.3. Overview of the Xedio Approval
Window

Illustration

The Xedio Approval window contains the areas highlighted on the screenshot below:

Note
The color of some user interface elements may vary with the Xedio skin
installed.
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Area Description

The table below describes the various parts of the Xedio Approval window:

Part Name Description

1. Player
pane

This pane is used to preview the selected object (media, edit or clip).

2. Database
list

This pane is used to select themedia, clip or edited packages to be
assessed for approval. Filtering tools can be applied to the list.

3. Approval
pane

This pane is used to display information about the selected object and
to accept or reject it.

Adaptable Display

The layout of the Xedio Approval can be adapted to users' needs.

The different panes can be hidden either by clicking the cross at the top right corner of
each pane or by selecting one of the options of the View menu: Player, List area
(Database List pane),Work area (Approval pane). The hidden pane(s) can then be
displayed by selecting the corresponding option of the View menu. Seven layouts are
available:

• Player + Approval pane + Database List

• Player + Approval pane

• Player + Database List

• Approval pane + Database List

• Player only

• Approval pane only

• Database List only

The different panes can be resized.

1.4. Process Overview
The use of Xedio Approval can be summarized as follows:

1. Select a media, edit or clip from the Database List.

See section "Database List Pane" on page 4.

2. Load it on the Player Pane.

See section "LoadingMedia on the PlayerWindow" on page 25.

3. Accept or reject the item.

See section "Approval Pane" on page 26.
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2. Database List Pane

2.1. Purpose
The Database List pane allows you to quickly find and browse the available items present
within the database that need to be considered for approval.

2.2. Overview of the Database List

TheMedia and Edit radio buttons above the Elements grid are used to select the item type
for which you want to get the list.

The upper part of the pane gives access to the different filters which can be applied to the
database list.

At least two tabs exist on the left of the Database List.

• The Filter 0 tab: Depending on the item selected, media, edits or clips, the element list
displays the list of all items present in the database, or it returns the result of a search
applied to the list.

• The Today tab: Depending on the item selected, media, edits or clips, the element list
shown the items with "creation date = today".

Additional tabs are displayed when the users have saved filters applied to the database.
See section "Using Saved Filters" on page 15 for more details. Items are displayed in
columns.
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2.3. Elements Grid

2.3.1. Sorting the Elements in the Grid
You can change the sort order of elements in the grid by clicking the column header for the
parameter according to which you want to sort the elements.

The blue arrow indicates the sorting order. Clicking the column header again changes the
sorting order from ascending to descending or vice versa.

2.3.2. Organizing Columns

Resizing Columns

A column can be resized by using themouse pointer over columns intersection and
dragging it to the right or to the left.

Selecting Columns to Display

To select the columns to display in the grid, proceed as follows:

1. Right-click the column header area.

A menu is displayed.

2. Select Choose Displayed Columns.

The Select Visible Columns window opens and shows the list of columns in the
current order.

3. To select the column(s) you wish to add to the view, do one of the following:

◦ in the left pane, double-click the column(s) you wish to add to the view

◦ select them in the left pane and click theAdd button

4. To select the column(s) you wish to remove from the view, do one of the following:

◦ on the right pane, double-click the column(s) you wish to remove from the view

◦ select them on the right pane and click the left arrow

5. Click OK.

Ordering Columns

To change the columns order, proceed in one of the following ways:

1. Select a column header

2. Drag it to the left or right to the required place.

A vertical line shows the place where the columnwill be dropped.

OR
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1. Right-click a column header.

A menu is displayed.

2. Select Choose Displayed Columns.

The Select Visible Columns window opens and shows the list of columns in the
current order.

3. Select the column name(s) from the Selected pane.

4. Click the appropriate button:

◦ Up: moves the item(s) before the previous one

◦ Down: moves the item(s) after the next one

5. Click OK.

2.3.3. Element Contextual Menu
A contextual menu with the following options is available when you right-click an item in
the list.

Play
Loads themedia in the Player to allow the element to be browsed andmodified.

Render List
Opens the Render List window listing all types of rendering that have been done with the
edit or media.

Archive History
Opens the Archive History window listing the archive and restore processes that were
achieved for the selected edit or media.

View Properties
Opens theMedia Properties window which shows the properties for the selected edit or
media. If a default metadata profile has been defined for themedia, ametadata tab is
displayed and shows the edit or mediametadata.
See the XedioManager manual for more information on the selection of a profile.

2.4. Searching for Elements in the List

2.4.1. Introduction
When the database contains large amounts of data, it may become difficult to find a
specific element. The Xedio Suite offers several ways to speed up your search:

• quick text search

• filters on parameters

6 2. Database List Pane
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By default, the columns that are taken into consideration for the Quick Text Search are the
ones currently visible in the grid.

If you wish to search in other columns, and view the string you are searching for in the
columns, you can:

• add other columns to the Elements grid view

• use Filters, as explained in section "Advanced Search" on page 9.

These search tools are explained in detail below.

An applied filter can be saved for later use. Such a saved filter can then be applied in one
click.

A search can also be facilitated by ordering the Elements grid.

2.4.2. Quick Text Search

Purpose and Context of Use
TheQuick Text Search function is used to perform a search based on free text entered in
theQuick Text Search field. This field is available on the top of the Elements grid.

It allows searching for a string in the displayed columns.

Users can enter a search string in one of the following ways.

• They enter the search string in full in theQuick Text Search field.

TheQuick Text Search option obeys specific rules which can be accessed via the

Help button next to theQuick Text Search field.
See section "Quick Text Search Rules" on page 7 for more details on these rules.

• They click the arrow next to theQuick Text Search field, so the last 10 searches are
displayed, and they select one of them.

Quick Text Search Rules
The string that you enter in theQuick Text Search field is analyzed according to the
following set of rules, which can be accessed via theHelp button next to theQuick
Text Search field.

The free text search is not a case sensitive operation.
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Search String Search Result

Yellow card Searches for the strings "yellow" and "card", even if in two different
fields (columns), for example "yellow" in Name and "card" in
Keywords.
For example a clip named "The Yellow Man" with keywords "Red
Card" will be found, since it has yellow and card in 2 different fields.

"Yellow card" Searches for strings containing "Yellow card".

Yellow | card Searches for "yellow" or "card", even if in two different fields
(columns), for example "yellow" in Name or "card" in Keywords.
Spaces around the | sign aremandatory.

yell* Searches for "yell" at the beginning of a string.

*low Searches for "low" at the end of a string.

Ye*low Searches for strings with "ye" at the beginning and "low" at the end.

Ye*low 123 Searches for strings with "ye" at the beginning and "low" at the end
and which contains "123".

=card Searches for a string exactly equals to "card".
For example, if a field contains "yellow card", the =card condition
will not return any result.

=”yellow card” Searches for a string exactly equals to "yellow card".
The use of quotes is required due to the space between "yellow" and
"card".

How to Perform a Quick Text Search
To perform aQuick Text search, proceed as follows:

1. Display the columns you wish to perform a quick search on.

2. Type a search string in theQuick Text Search field, based onQuick Text search
rules available from theHelp button and detailed in section "Quick Text Search
Rules" on page 7.

3. Click theSearch button to apply the Quick Text Search.

Depending on whether theAutoRefresh Filtering setting is selected or not, youmay
not have to click theSearch button to apply the Quick Text Search. Refer to the tab
Software > Parameter Profiles > General > General in XedioManager.

The search result is displayed in the grid.

4. To clear the applied Quick Text Search, click the red button to the right of the
search field or select <empty> from theQuick Text Search drop-down list.
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2.4.3. Advanced Search

Purpose and Context of Use
The Advanced Search functions are available for more detailed search operations. They
allow searches onmedia and edits metadata.

From the Today tab, the filter "creation date = today" is automatically applied.

The Advanced Search fields can be displayed on the top left part of the Elements grid.

Advanced Search Fields Display

Displaying Advanced Search Fields

Show/Hide Filter Button

To display the Advanced Search fields, click theShow/Hide Filter button above the
grid.

The Advanced Search area is expanded as follows:

TheShow/Hide Filter button can be displayed with two different colors:

Button
Display Meaning

(gray)

TheShow/Hide Filter button is gray when all filter criteria are hidden.
Consequently, the filters are inactive.

(colored)

TheShow/Hide Filter button is colored when the Advanced Search area is
visible, even if no filtering criterion is applied.

Criteria Combination Field

The first field under theShow/Hide Filter button lists three options for the combination of
criteria to be taken into account during the filtering operation.
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Option Meaning

ALL criteria
are met

All the criteria selected in the Filter fields displayed under theCriteria
Combination field must bemet.
Themedia displayed in the Elements grid fulfill all the selected filter
criteria.

ANY criteria
is met

At least one of the criteria selected in the Filter fields must bemet.
Themedia displayed in the Elements grid fulfill at least one of the
selected filter criteria.

NO criteria
is met

None of the criteria selected in the Filter fields displayed under the
Criteria Combination field must bemet.
Themedia displayed in the Elements grid fulfill none of the selected filter
criteria.

Search Parameters List

The second field gives access to the list of available advanced search parameters. Click
the arrow next to the field to display the list.

Users are then able to add as many search fields as needed and to enter search criteria for
each of them.

Advanced Search Fields

Once a search parameter has been selected, an entire line is displayed.

Interface
Element Description

1 Selected search parameter.

2 Various fields used to enter the filter criteria. See section "Advanced
Search Fields Types" on page 11.

Used to remove the corresponding filter line.

Used to add a new filter line.

Hiding Advanced Search Fields

To hide all the Advanced Search fields, click theShow/Hide Filter button again.
Consequently, all the applied filters are removed.

To remove an Advanced Search field from the Advanced Search area and thus clear the

corresponding applied filter, click the button next to the field.
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Advanced Search Fields Types
Depending on the selected search parameter, different types of advanced search fields
will be displayed and available to enter criteria.

Timecode or Duration Parameter

Such as TC IN, TC OUT, Duration…

1. Select a logical operator in the first field

2. Enter a timecode or duration value in the second field.

Timecode Range

1. Select an option from the first field

2. Enter a timecode value.

This will include, or exclude, media containing the specified timecode value.

Date

Such as Creation Date

Several Date Search filters exist.

1. Select a condition or a logical operator in the first field
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2. This will condition the next step:

◦ Search based on a specific date (e.g. with =…): a calendar will be displayed for
the selection of a date.

◦ Search based on an interval (e.g. with […] (between)…): two calendars are
displayed for the selection of two dates.

◦ Search based on a specific date calculated from the current date (e.g. with
tomorrow, last month,…): no other field appears.

Time

Such as Last Rendered Date Time

Several Date Search filters exist.

1. Select a condition or a logical operator in the first field
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2. This will condition the next step:

◦ Search based on a specific date and time (e.g. with =…): two additional fields will
be displayed, a calendar for the selection of a date and drop-down list for the
selection of time.

◦ Search based on a specific date and time calculated from the current date and
time (e.g. with next hour, last month,…): no other field appears.

Number

Such as DB Id

1. Select a logical operator in the first field

2. Enter a number in the second field.

Note
<>means "differs from".

Option List

Such as Video Standard

1. Select a logical operator in the first field

2. Click the button to display the list of options available for the selected filter
parameter.

Example for the Video Standard:

3. Select an option from the list.
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Boolean

Such as Published

• Select Yes or No from the single criteria field.

Free Text

Such as Label

1. Select a condition in the first field.

2. Enter free text in the second field.

How to Perform an Advanced Search
To enter search values in the Advanced Search fields, proceed as follows:

1. Choose the columns you wish to perform a search on.

2. Click theShow/Hide Filter button
The Advanced Search area is displayed:

3. Select a criteria combination from the list:

4. Select a search parameter from the list of parameters.

An entire line, corresponding to the selected filter parameter, is displayed:
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5. Enter filter criteria as explained in section "Advanced Search Fields Types" on page
11.

For free text fields, press ENTER to apply the filter.

Otherwise, the Elements grid is automatically filtered and refreshed.

6. If required, click the button to add another advanced search parameter.

2.4.4. Using Saved Filters

Introduction
Once you have defined filters and search terms, youmay want to save them for later use.
You will then be able to apply the same set of filters with a single click.

Saved filters appear as tabs.

At least two tabs exist on the left of the Elements grid.

• The Filter 0 tab: The Elements grid displays the list of all elements present in Xedio
Dispatcher, or it returns the result of a search applied to the list.

• The Today tab: the Elements grid shows the elements with "creation date = today".

Warning
Those filters can bemodified by the user, so the results could no longer reflect
the tab label.

Saved Filter Contextual Menu
Right-clicking in the Filter 0 tab displays a contextual menu with the following options:

Create New Filter
Allows to create a new filter tab through the Filter Edit Dialog wndow:

Save Filter As
Allows to create a new filter tab in which the current search filter will be saved.

Filter Properties
Allows to change the name and/or description of the selected filter tab.

Reset Filter
Removes all search criteria on the selected filter tab.

Delete Filter
Removes the filter tab.
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How to Save Filters
To save filters, proceed as follows:

1. Define the filter or filters combination you wish to save, as explained in section "How
to Perform an Advanced Search" on page 14.

2. Right-click the Filter 0 tab.

3. Select Save Filter As from the contextual menu.

The Filter Edit Dialog box opens.

4. Enter a label for the tab you are going to create and, if required, enter a description.

5. Click OK.

The new filter tab is displayed on the left of the list.

How to Apply a Saved Filter
To apply a saved filter, simply click the corresponding tab.
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3. Player

3.1. Purpose
The Player pane is used to preview the selected objects from the Database List.

3.2. Overview of the Player Pane
The Player pane provides a video display, amedia bar and a jog bar to navigate within the
element, video and audio selection buttons, transport buttons and timecode fields. It
slightly differs according to the element loaded.

When amedia is loaded from the Database List pane, the Player pane looks as follows:

Everything that is outside the video content has the skin color. Video such as letterboxed
or pillarboxed video will show black bars as thesemattes are part of the video signal.
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3.3. Video Display Options
A contextual menu is available when right-clicking the Video Display area. This gives
display options for the video.

Option Meaning

Show
Timecode

This option offers various options to display timecode on the Player
window.
• none: does not display timecode.
• Start TC: shows a counter starting with 0 at the first frame of the

media.
• Intra TC: shows the original timecode of themedia.
• Both: displays both the counter and the original timecode.

Aspect Ratio This option offers a choice of aspect ratios for the display: Auto, 4:3 or
16:9.

Show
SafeAreas

This option displays a safe area cage on the window to determine
which areas of the picture will be seen. This allows to check the size of
graphics within themedia for safe display.

Deinterlacer This option is used to de-interlace video. A submenu provides the
following options:
• Mix top/bottom: displays 25 full pictures per second, eachmade

by mixing the top field and the bottom field and repeating each
mixed line.

• Top: displays 25 full pictures per second, eachmade by duplicating
each line of the top field.

• Bottom: displays 25 full pictures per second, eachmade by
duplicating each line of the bottom field.

• None: displays 25 pictures per second, eachmade from both
interlaced fields.

3.4. Player Controls

3.4.1. Transport Buttons
The following table gives themeaning of each transport operation.

Operation User Interface Button Description

Play and
Pause ↔

Button used to start/stop the preview
(video and/or audio) of the selected item.

Go to Start of
Media

Button used tomove from the current
position to the beginning (on the first
frame) of the selected item.

18 3. Player

EVSBroadcast Equipment SA Issue 4.35.B - August 2013



Operation User Interface Button Description

Go to End of
Media

These buttons are used tomove from the
current position to the end (on the last
frame) of the selected item.

Goto
Previous
Frame

Button used tomove from the current
position to the previous frame.

Goto Next
Frame

Button used tomove from the current
position to the following frame.

Fast Rewind Button used to start moving backwards
through themedia at a preset fast speed.

Fast Forward Button used to start moving forwards
through themedia at a preset fast speed.

3.4.2. Timecode Value Fields

Three Timecode Value fields are displayed under the Transport buttons.

Field Description

1. Media, Edit or Clip Start Timecode (first recorded frame)

2. Current Timecode position (nowline)

3. Media, Edit or Clip End Timecode (last recorded frame), even if a virtual
media is loaded.

3.4.3. Video and Audio Monitoring Tools

Selecting Video and Audio Tracks for Media and
Clips

Overview of the Video and Audio Tracks

The video and audio channels of a loaded source file are represented below the Video
Display of the Player when clips or media are loaded on the Player pane in the form of
Track Selection buttons.
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Here is an example with 4 tracks of stereo channels:

The different types of audio tracks of a loadedmedia or clip are displayed as follows:

• Amono track is represented by

• A stereo track is represented by .

• A 5.1 track is represented by

Note
If the loadedmedia/clip contains more than 8 audio tracks, only the first 8 tracks

are displayed under the Video Display. A first click on the button allows to
display the additional tracks.

Video and Audio Tracks Selection

Selection of the Video Channel

TheVideo button is clicked to select or remove the video. So the clip contains, or not,
the video.

Selection of an Audio Channel

The left and the right loudspeaker buttons of an audio stereo track are used to
select or remove respectively the left or the right channel of the corresponding audio track:

Clicking the left audio button will remove the left audio component from the source so that
the clip has no left audio channel. In this case, the right channel will be output on the left
and right channels.

Clicking both left and right audio buttons will also remove the right audio component so
that the clip has no audio channel for this track.
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A mono track is removed from the selection by clicking the loudspeaker button on the right
of the radio button:

A 5.1 audio track is removed from the selection by clicking the loudspeaker button on the
right of the radio button:

The next table summarizes how the buttons look like depending on the selection:

Selected Removed

Video

Audio

Selection of the Track for Audio Monitoring

The radio buttons displayed between each pair of stereo channel buttons or next to a
mono or 5.1 audio channel button allow the selection of one audio track for monitoring:

Note
When you right-click on a 5.1 radio button, a popupmenu appears in which you
can select the 5.1 components that should bemonitored on the left and right
channels. You can choose between the following options: Mixed, L+R, Ls+Rs
or Center (output on L+R speakers).
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Audiometers located on the right side of the Video Display represent the audio channels
of themonitored track.

Selecting the Monitored Audio Track for an Edit

Number and Type of the Edit Audio Tracks

When an edit is loaded on the Player pane, the number and type of the output audio tracks
are displayed as radio buttons under the Video Display. Here is an example:

Selection of the Track for Audio Monitoring

The selection of the audio track you want to monitor is done by clicking one of the radio
buttons.

A set of audiometers are displayed on the right side of the Video Display.

3.4.4. Media Bar and Jog Bar

Media Bars

Top Bar

The top bar represents themedia, or a portion of it, currently loaded on the Player.

Media

When amedia is loaded, only the nowline is displayed:

Edit

When an edit is loaded, only the nowline is displayed:
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Clip

When a clip is loaded, the IN point, the OUT point and the nowline are displayed on this
top bar.

Middle Bar

Themiddle bar is used to zoom into the loaded element.

Its dark gray zone shows the section of themedia, out of the wholemedia, visible in the
top bar and the relative position of the visible section in the wholemedia.

• When amedia or an edit has just been loaded, the top bar represents the wholemedia.
The dark gray zone covers the whole length of themiddle bar:

• When a clip has just been loaded, the top bar represents the wholemedia. The dark
gray zone represents the wholemedia and covers the whole length of themiddle bar:

• When a clip is loaded, double-clicking on the dark gray zone toggle the section
covered by the top bar from the wholemedia length to the clip length (betweenmark
IN andmark OUT), and vice-versa:

The dark gray zone is reduced to represent the clip length and position with regard to
the wholemedia.

• If you position themouse on themiddle bar and rotate themouse wheel up or down,
you respectively increase or reduce the section of themedia visible in the top bar.
Thus, the dark gray zone is enlarged or reduced:
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• If you click on the dark gray zone and drag it to the left or to the right, you shift the
section of media visible in the top bar to the beginning or to the end of themedia.

Nowline

Display

The nowline, representing the current position within the loaded element, is shown as a
blue line on themedia bar:

To place the nowline at a given position, simply click at the requested position on the
media bar or drag the line to a new position.

Nowline Outside Media Bar

When themedia is being played, the nowlinemoves along the topmedia bar. If only a
section of themedia is visible in the top bar, the nowlinemay disappear. In this case, a red
indicator, on the right side of themedia bar will be displayed. A click on the vertical
indicator (on the right side) will re-center the top bar on the nowline.

Moving themiddle bar to the right or to the left can lead to such a situation, with the
nowline disappearing respectively to the left or to the right of the top bar.

Jog Bar
The bottom bar is the jog bar.

Dragging the speed indicator on the jog bar allows you tomove within themedia at a
variable speed:

The speed varies depending on:

• the position of the speed indicator

• the speed range covered by the jog bar. The default range is set from -200% to
+200%. This is set in XedioManager.

Audio can be heard when using the jog.
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3.5. Loading Media on the Player Window
You can proceed in different ways to load an item on the Player:

• Drag themedia, edit or clip from the Database List to the Player window:

• In the Database List, double-click themedia, edit or clip to load

Once the item is loaded, the Approval Pane displays themedia, edit or clip properties.
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4. Approval Pane

4.1. Purpose
Themain purpose of the Approval pane is to reject or accept amedia, edit or clip.

4.2. Item Properties
The upper part of the Approval pane displays the properties of the loaded item in the
General tab and its associatedmetadata in theMetadata tab.

Some of those properties are only for display and cannot bemodified at this stage, while
others can be updated, such as metadata, Media ID/Edit ID/Clip ID, Description, Edit On-
air Date. To update a field, enter a new value in the required field and click theUpdate
button.

The user can also add a previewed status to themedia by selecting the previewed box
and then clicking theUpdate button. This will be reflected in the Previewed column of the
Database List.

TheProperties fields differ according to the item loaded on the Player:
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Media

Edit

4.3. Acceptance Buttons
The lower part of the Approval window is common to all kinds of item and is used to
Accept orReject themedia.

To reject an item, click theReject button and then theUpdate button. "REJECTED" will
be displayed in the Validated Date column of the Database List.

To accept an item, click theAccept button and then theUpdate button. The approval date
will be displayed in the Validated Date column of the Database List.

Note
The Xedio Approval application can be set up by the administrator of the system
to lock any edit or media once it has been validated by the user. This feature can
be used to prevent accidental use of thematerial once an editorial decision has
beenmade. This is enabled in XedioManager > Softwares.
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To learn more about EVS go to www.evs.com

Corporate
+32 4 361 7000

North & Latin America
+1 973 575 7811

Asia & Pacifi c
+852 2914 2501

Other regional offi ces
www.evs.com/contact

EVS Broadcast Equipment is continuously adapting and improving its products in accordance with the ever changing
requirements of the Broadcast Industry.
The data contained herein is therefore subject to change without prior notice. Companies and product names are
trademarks or registered trademarks of their respective companies.

EVS Headquarters

Liège Science Park
16, rue Bois St Jean
B-4102 Seraing
Belgium
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